
Previous TF Editor version 

Information 
 

V4.02 

Fixed Bugs (V4.02) 

• Solved the problem in which the recall safe status would not be updated when loading a 

settings file (.TFF file) to version 4.00/4.01 of the TF5/F3/TF1/TF-RACK or version 4.00 of 

the TF Editor. 

Additional Functions (V4.00) 

• The Selected Channel section has been added to the OVERVIEW screen, allowing you to 

edit sounds for each channel in a single screen. To display the Selected Channel section, 

set the “CH Strip & Selected Channel” of the Home Button Function in the Setup menu to 

ON. 

• Added the FADE TIME function for Scene. Only the FADE TIME setting is available in the 

TF Editor. 

• Added MUTE GROUP 3 to MUTE GROUP 6 to which channels are freely assignable. To 

assign channels, use the MUTE GROUP ASSIGN screen of the SETUP screen, or the 

ASSIGN screen of each channel. 

• The “ON” and “Fader” parameters for the recall safe function can now be set individually. 

• Added Copy/Paste to the menu of the SEND FROM screen, to copy/paste the SEND level 

for the AUX/MATRIX/SUB channels. 

• Added CH Copy with Sends/CH Paste with Sends to the menu of the AUX/MATRIX/SUB 

channels. 

• Added the Group Bypass function to the AUTOMIXER screen. 

• Added assignable functions to the USER DEFINED KEYS and the FOOT SWITCH. 

o Group Bypass and Channel ON/OFF for the Automixer 

o MUTE GROUP 3 to MUTE GROUOP 6 for the Mute Master 

• Added the Channel Delay function to the ST IN 1/2 channels. 

• Added new Presets to the Channel Library. Also, some previous Presets have been 

modified. 



Specification Changes (V4.00) 

• Changed the CH STRIP area’s ON button operation when the Mute Group Master is ON. 

V3.60 

New feature (V3.60) 

• The “RTA Offset” function has been added and can be assigned to the [USER DEFINED 

KNOBS] on the USER DEFINED CONTROLS screen. 

V3.51 

New features (V3.51) 

• Now supports macOS 10.14. 

Fixed bug (V3.51) 

• Solved a problem in which, when using the TF Editor V3.50 in TF5 or TF3 mode, operating 

the Stereo Link function in the Input List screen might force the application to close. 

New features (V3.50) 

• Channels 1 – 8 can be used with the Dugan Automixer.  

Scenes saved via the TF series V3.11 or earlier do not include the Automixer parameters. 

This means that Automixer parameters will not change even such Scenes are recalled. 

• Added AUX Send point selection, Pre EQ or Pre Fader, for a channel to which AUX Send is 

set to Pre. 

• Added the “frame” unit for the Delay Time parameter setting in the Monitor Delay effect of 

OUTPUT channels and the OUTPUT DELAY effect. 

• Added the PFL Trim setting in the MONITOR CUE screen. 

• Added the stereo pair setting for the MATRIX1/2 bus and MATRIX 3/4 bus. 

• Added “MONITOR” in the OUTPUT tab on the INPUT LIST screen. Only patching to the 

OMNI OUT is available. 

Specification changes (V3.50) 



• Changed the “Last CUE” mode to the CUE stack* operation, same as with the “MIX CUE” 

mode.  

*CUE stack: turning off the CUE for a low priority channel enables the CUE for a high priority 

channel to be turned on again. 

• Changed the [ON] button function of the CH STRIP area when the [INPUT] button or the 

[FX] button of the MUTE area is turned on.  

V3.11 or earlier: Pressing an [ON] button turns the temporary cancelation for mute function 

on/off  

V3.50 or later: Pressing an [ON] button temporary removes the channel from the mute group 

V3.10 

New features 

• Added the “Input List” screen to view and edit channel names, channel colors, channel 

icons, etc. for each channel of the TF series in a list form. 

V3.01 (Win) 

Additional Function 

• Now supports the TF-RACK. 

• Ensured that the STEREO/SUB Level Link function maintains offsets.  

[NOTICE]  

Offset values will also be saved in a Scene. However, Scenes saved via the TF series V2.50 or 

earlier do not include Offset values. This means that Offset values will not change even if such 

Scenes are recalled. 

• Added bus sends from the AUX9/10 – AUX19/20 busses to the SUB bus. 

• Added a SEND FROM screen to the FX1/FX2 channels. 

• Added the Matrix1-4 meters in the TOOLBAR. 

• New Presets have been added to the default Presets of the Channel Library. To add them to 

the Library list, execute “Initialize All Memory” after updating to V3.0. 

Specification changes(V3.00) 



• Added the threshold link function of the “Multi Band Comp” effect to keep offsets between 

the Low, Mid, and High parameters. In addition, the Make Up parameter has been removed 

to avoid a sudden change of volume. 

• Changed the Input Gain offset link action between stereo link channels to keep the offset 

value even if the Input Gain is set to maximum or minimum. 

• The SYSTEM SETUP screen and the USER SETUP screen have been consolidated to the 

SETUP screen. 

• Connection to a TF series unit now requires the Administrator password. 

• Changed the specification to not load the settings of channel selection, fader bank selection, 

and SENDS ON FADER in the TF setting file (.TFF). 

• The available file type in the browser window displays when executing Load/Save/Save As 

menu has been unified to the .TFF file. 

Specification changes(V3.01) 

• (TF-RACK only) Changed OMNI OUT Patch settings of the Preset Scenes to “ST L=OMNI 7” 

and “ST R=OMNI 8,” which matches the rear panel printing.  

This change will be reflected when executing the “Initialize All Memory” function after 

updating to V3.01. 

Improvements 

• The separator in the Manage Library/Scene screen allows you to change sizes of left and 

right panes. In addition, the layout has been changed. 

Fixed bugs(V3.00) 

• Solved a problem in which executing the “Initialize Memory” menu caused a forced 

termination of the TF Editor while the INPUT screen of the ST IN channel was displayed. 

• Solved a problem in which operating a category of the MATRIX channel Library in the 

Manage Library/Scene screen caused a forced termination of the TF Editor. 

• Solved a problem in which the Send Pan parameter set to center when executing the “All 

Nominal” context menu in the SEND FROM screen. 

• Solved some minor bugs. 

Fixed bugs(V3.01) 



• Solved a problem in which, when operating the analog gain (A.Gain) of a channel not set to 

the Stereo Link function, and if Stereo Link has been set to the channel using the same 

INPUT jack (TF5:CH1-8 and CH33-40, TF3:CH1-16 and CH25-40, TF1:CH1-16 and CH17-

32), the unlinked channel would also link to the corresponding next channel regardless of 

the input source selection. 

Known issue 

• When updating the TF Editor from V2.50 or earlier to V3.00, the network interface selection 

will be initialized. Select a network interface to connect the TF Editor and the TF series unit 

via “Setup” -> “Network Interface” menu as necessary. 

V3.01 (Mac) 

Additional Function 

• Now supports the TF-RACK. 

• Ensured that the STEREO/SUB Level Link function maintains offsets.  

[NOTICE]  

Offset values will also be saved in a Scene. However, Scenes saved via the TF series V2.50 or 

earlier do not include Offset values. This means that Offset values will not change even if such 

Scenes are recalled. 

• Added bus sends from the AUX9/10 – AUX19/20 busses to the SUB bus. 

• Added a SEND FROM screen to the FX1/FX2 channels. 

• Added the Matrix1-4 meters in the TOOLBAR. 

• New Presets have been added to the default Presets of the Channel Library. To add them to 

the Library list, execute “Initialize All Memory” after updating to V3.0. 

Specification changes(V3.00) 

• Added the threshold link function of the “Multi Band Comp” effect to keep offsets between 

the Low, Mid, and High parameters. In addition, the Make Up parameter has been removed 

to avoid a sudden change of volume. 

• Changed the Input Gain offset link action between stereo link channels to keep the offset 

value even if the Input Gain is set to maximum or minimum. 

• The SYSTEM SETUP screen and the USER SETUP screen have been consolidated to the 

SETUP screen. 



• Connection to a TF series unit now requires the Administrator password. 

• Changed the specification to not load the settings of channel selection, fader bank selection, 

and SENDS ON FADER in the TF setting file (.TFF). 

• The available file type in the browser window displays when executing Load/Save/Save As 

menu has been unified to the .TFF file. 

Specification changes(V3.01) 

• (TF-RACK only) Changed OMNI OUT Patch settings of the Preset Scenes to “ST L=OMNI 7” 

and “ST R=OMNI 8,” which matches the rear panel printing.  

This change will be reflected when executing the “Initialize All Memory” function after 

updating to V3.01. 

Improvements 

• The separator in the Manage Library/Scene screen allows you to change sizes of left and 

right panes. In addition, the layout has been changed. 

Fixed bugs(V3.00) 

• Solved a problem in which operating a category of the MATRIX channel Library in the 

Manage Library/Scene screen caused a forced termination of the TF Editor. 

• Solved a problem in which the Send Pan parameter set to center when executing the “All 

Nominal” context menu in the SEND FROM screen. 

• Solved some minor bugs. 

Fixed bugs(V3.01) 

• Solved a problem in which, when operating the analog gain (A.Gain) of a channel not set to 

the Stereo Link function, and if Stereo Link has been set to the channel using the same 

INPUT jack (TF5:CH1-8 and CH33-40, TF3:CH1-16 and CH25-40, TF1:CH1-16 and CH17-

32), the unlinked channel would also link to the corresponding next channel regardless of 

the input source selection. 

Known issue 

• When updating the TF Editor from V2.50 or earlier to V3.00, the network interface selection 

will be initialized. Select a network interface to connect the TF Editor and the TF series unit 

via “Setup” -> “Network Interface” menu as necessary. 



V2.00 (Win) 

Additional Function 

• Added “Ping Pong Delay” and “Dual Pitch” effect types. 

• Added the “Manage Library/Scene” window to manage Libraries and Scenes. 

• Added the menu to open the website for downloading Channel Libraries (QuickPro Presets). 

• Added the “All Nominal” function to set the send level settings of all AUX busses or SUB bus 

to nominal (0 dB) in the menu of each SEND FROM screen. 

• Added the “Dup. STEREO” function to set the send level settings of AUX busses or SUB bus 

to the same settings of the channel faders in the menu of each SEND FROM screen. 

• Added the function to send to the SUB bus from ST IN1/2 or FX RTN 1/2. 

NOTE 

When recalling a Scene, or a Channel Library stored via the V1.xx version, these send parameters 

are not changed. 

• Added some default Presets in the Channel Library. Some Preset data have been modified.  

This change will be reflected when executing the “Initialize All Memory” function after 

updating to V2.00. 

Specification Changes 

• Changed the specification in which the channel names of each stereo-linked mono channel 

are not linked. However, the channel names link in the permanent stereo channels such as 

ST IN, AUX9/10, etc. 

• The reverb/ER effects are now available in all FX/InsFX. 

Improvements 

• Improved the Library screen. 

o Unrecallable Libraries are not listed. 

o You could recall each module such as EQ, COMP, FX, etc from a Preset with different 

channel types. 

• Network setting is now available when no devices are connected to the Network connector. 



• The data transfer for Meters is now available between the TF series and the TF Editor even 

when the DHCP server does not exist with the network setting is set to DHCP. 

• When recalling or storing a Scene via the TF Editor, or StageMix, the Scene number and 

name displays in the TF series are also follow them. 

Fixed bugs 

• Solved a problem in which when operating the analog gain when the input source setting 

has been set to “INPUT” and channel link has been set to the channel, the analog gain of 

the channel using the same input signal of the INPUT port (TF5: CH1-8 and CH33-40, TF3: 

CH1-16 and CH25-40, TF1: CH1-16 and CH17-32) will link regardless of the input source 

selection. 

• Solved the problem in which the meter could not hold the peak of the OVER level. 

• Solved the problem in which some meters would not work properly when loading the setting 

file with a different meter point setting. 

• Solved some minor bugs. 

V2.00 (Mac) 

This version is not support Mac OS X 10.11.x. 

Additional Function 

• Added “Ping Pong Delay” and “Dual Pitch” effect types. 

• Added the “Manage Library/Scene” window to manage Libraries and Scenes. 

• Added the menu to open the website for downloading Channel Libraries (QuickPro Presets). 

• Added the “All Nominal” function to set the send level settings of all AUX busses or SUB bus 

to nominal (0 dB) in the menu of each SEND FROM screen. 

• Added the “Dup. STEREO” function to set the send level settings of AUX busses or SUB bus 

to the same settings of the channel faders in the menu of each SEND FROM screen. 

• Added the function to send to the SUB bus from ST IN1/2 or FX RTN 1/2. 

NOTE 

When recalling a Scene, or a Channel Library stored via the V1.xx version, these send parameters 

are not changed. 



• Added some default Presets in the Channel Library. Some Preset data have been modified.  

This change will be reflected when executing the “Initialize All Memory” function after 

updating to V2.00. 

Specification Changes 

• Changed the specification in which the channel names of each stereo-linked mono channel 

are not linked. However, the channel names link in the permanent stereo channels such as 

ST IN, AUX9/10, etc. 

• The reverb/ER effects are now available in all FX/InsFX. 

Improvements 

• Improved the Library screen. 

o Unrecallable Libraries are not listed. 

o You could recall each module such as EQ, COMP, FX, etc from a Preset with different 

channel types. 

• Network setting is now available when no devices are connected to the Network connector. 

• The data transfer for Meters is now available between the TF series and the TF Editor even 

when the DHCP server does not exist with the network setting is set to DHCP. 

• When recalling or storing a Scene via the TF Editor, or StageMix, the Scene number and 

name displays in the TF series are also follow them. 

Fixed bugs 

• Solved a problem in which when operating the analog gain when the input source setting 

has been set to “INPUT” and channel link has been set to the channel, the analog gain of 

the channel using the same input signal of the INPUT port (TF5: CH1-8 and CH33-40, TF3: 

CH1-16 and CH25-40, TF1: CH1-16 and CH17-32) will link regardless of the input source 

selection. 

• Solved the problem in which the meter could not hold the peak of the OVER level. 

• Solved the problem in which some meters would not work properly when loading the setting 

file with a different meter point setting. 

• Solved some minor bugs. 

V1.13 (Win) 



Improvements 

• Improved the lighting/flashing/off function of the ON button in the Channel Strip area for 

more intuitive understanding of muted channels, specifically when turning on the INPUT 

button or FX button in the MUTE area, or when operating the ON buttons of DCA1 – 8. 

• Improved the function in which an operation in the SENDS ON FADER area is related with 

an AUX channel to CUE when the CUE function for an AUX channel is set to on. 

Fixed bugs 

• Solved a problem in which when you zoom up/down the display size via the Zoom function in 

the Window menu, the previous zoom size could not be restored even if it was set. 

• Solved a problem in which when you export a Preset in the LIBRARY window via a touch 

operation, the application will slow down in action. 

Known Issue 

• A problem would occur in which some level meters are not displayed at the correct meter 

point after loading a console data file (.tff) which uses a different meter point.  

Changing the meter point in the meter display solves the problem. 

V1.13 (Mac) 

Specification Changes 

• The function of the green button at the upper left of the window has been changed from "full 

screen" to "maximization." 

Improvements 

• Improved the lighting/flashing/off function of the ON button in the Channel Strip area for 

more intuitive understanding of muted channels, specifically when turning on the INPUT 

button or FX button in the MUTE area, or when operating the ON buttons of DCA1 – 8. 

• Improved the function in which an operation in the SENDS ON FADER area is related with 

an AUX channel to CUE when the CUE function for an AUX channel is set to on. 

Fixed bug 

• Solved a problem in which when you zoom up/down the display size via the Zoom function in 

the Window menu, the previous zoom size could not be restored even if it was set. 



Known Issues 

• The application will slow down in action when you zoom up the display via the Zoom function 

in a Mac with Retina display. 

• A problem would occur in which some level meters are not displayed at the correct meter 

point after loading a console data file (.tff) which uses a different meter point.  

Changing the meter point in the meter display solves the problem. 

V1.12 (Win) 

Additional Function 

• Add a Zoom function (100%, 150%, and 200%) to the Window menu. 

Specification Changes 

• Changed the About menu to the Help menu. (Windows) 

• The default Presets are now set to read-only. In addition, some Presets have been modified. 

To apply these changes, execute “Initialize All Memories” after updating the TF Editor to 

V1.12. 

Fixed bugs 

• Solved some minor bugs. 

Known Issue 

• We found a problem that some level meters are not displayed at the correct meter point after 

loading a console data file (.tff) which uses a different meter point.  

Changing the meter point in the meter display solves the problem. 

V1.10 

The initial release version. 


